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While Deltek has attempted to verify that the information in this document is accurate and complete, 
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all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published December 2021. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
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Overview 
The Cobra 8.4 Cumulative Update 08 release includes all of the enhancements, software issues resolved, 
and database changes that were made in Cobra 8.4 CU 08. 

Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before 
applying this update, consider whether you have any custom programs or reports in the application area 
affected by the update. If so, contact Deltek Customer Care at http://support.deltek.com before you install 
the update. 

 

Viewing the Online Help 
If you use Internet Explorer and the online help does not display correctly, you need to turn off 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display 
intranet sites in Compatibility View check box. Then refresh the browser. Make sure you remove 
deltek.com (if listed) from the Websites you have added to Compatibility View list. You could also elect 
to use hosted help or the FQDN of your server in the URL (for example, server.domain) to bypass this 
issue. Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked 
content” when viewing the online help locally. The Cobra 8.4 Help System URL is 
https://help.deltek.com/Product/Cobra/8.4/GA. 

Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked content” 
when viewing the Cobra Online Help locally. This only affects Internet Explorer.  

You may also access the online help using Edge, Chrome, and Firefox. 

Attention: For steps to install the cumulative update, see Appendix A: Download and Install the 
Cumulative Update. 

http://support.deltek.com/
https://help.deltek.com/Product/Cobra/8.4/GA/Cobra%208.0%20Help%20System.html
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Cobra 8.4 Cumulative Update 08 
Released: December 20, 2021 

Enhancements 

BCR Analysis Report Enhancements 
This release contains updates to support running of the Budget Change Request (BCR) Analysis report in 
PM Compass. 

 

Allow Freezing of Multiple Columns and Rows in a Report Template 
File 
You can now freeze multiple rows and columns in a report template file. When you run the Report Wizard, 
the changes you made to the report template file are applied to the generated report. 

Support for Primavera P6 20.12 
Cobra now supports Primavera® P6 20.12 beginning with version 8.4 Cumulative 08 onwards. 

Match Work Package Forecast Dates with Dates Loaded from a 
Schedule during Integration 
Cobra now allows you to match work package forecast start and finish dates with dates loaded from a 
schedule during integration. In order to support this feature, the Force existing Work Package baseline 
dates to match the schedule option on the Change Control page of the Integration Wizard has been 
changed to Force existing Work Package dates to match the schedule for, with a list of dates 
displayed depending on the dates being loaded from a schedule. 

Attention: See “Cobra Integration Updates” in the Deltek PM Compass 8.2 Cumulative Update 05 
Release Notes for Lockheed Martin Aeronautics. 
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Change Control Page of the Integration Wizard 

 

Software Issues Resolved 

API » Web Services 

Defect 1544675  

Description: When using Costpoint version 8.1 or earlier, the Integration-Actual Costs process with 
control account code assignments did not work. 

Customers Impacted: This defect affects customers integrating with Costpoint. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WebService.Host.exe 

 Cobra.WebService.dll 

File » Integration Cost Data Export 

Defect 1409679  

Description: When you ran the Cost Data Wizard on a master project while in the Master Projects view, 
Cobra encountered an application error. 

Customers Impacted: This defect affects customers who use the Cost Data Wizard. 

Note: For more information, see the “Change Control Page of the Integration Wizard” help topic. 

https://help.deltek.com/Product/Cobra/8.4/GA/Change%20Control%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
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Workaround Before Fix: Run the Cost Data Wizard while in the Projects view instead of the Master 
Projects view. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

File » Integration Wizard-Project Data 

Defect 1431445  

Description: When you performed multi-project concurrent integration using the Integration Wizard to 
load status data and selected the Send to process server option on the Save and Load page, Cobra 
encountered errors. 

Customers Impacted: This defect affects customers who run concurrent Cobra processes. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1550439  

Description: When you ran the Integration Wizard to import one file with activity and resource 
assignment data, and a result field on the Import File Field Mapper page contained "BE" within the result 
name, the integration failed with the following error: "SQL: Column '<resultname>' is not found." 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Use two separate files during import (one activity file and one resource 
assignment file). 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Project Processes » Assignment Export or Import 

Defect 186735 

Description: When you ran the Assignment Export Wizard and the resource exported contained special 
characters (&, <,>, ', ", ..., ’), Cobra displayed an unexpected token error message. 

Customers Impacted: This defect affects customers who use the Assignment Export Wizard. 
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Workaround Before Fix: Remove the special character in the resource name. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Database Changes 
This section includes changes made to the database. There are no database changes in this release. 

Data Changes 
This section includes changes to the data applied by script. There are no data changes in this release. 

Documentation Changes 
This section includes details of section changes in the printed documentation.  

Document Details 

Cobra 8.4 
Installation 
Guide  

 Added Primavera P6 20.12 to the Supported Deployment Technology table. 

Cobra 8.4 
Technical 
Overview and 
System 
Requirements 
Guide 

 Added Primavera P6 20.12 to the Supported Deployment Technology table. 

Cobra 8.4 
Online Help 

 Added a note about the freezing multiple rows and columns in a report 
template file to the “Report Templates” help topic. 

 Added a note about specifying the data source in 
ServiceIdentityData.DataSourceKey property if Cobra is configured under 
Standalone or Server Deployment environment and that it has multiple data 
sources to the following help topics: 

 Connecting to the Cobra Web Service Host 

 Explaining the SampleClientAPI Code  

https://help.deltek.com/Product/Cobra/8.4/GA/Report%20Templates.html
https://help.deltek.com/Product/Cobra/8.4/GA/Connect%20to%20the%20Cobra%20Web%20Service%20Host.html
https://help.deltek.com/Product/Cobra/8.4/GA/Explaining%20the%20SampleClientAPI%20Code.html
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Appendix A: Download and Install the 
Cumulative Update  

Download the Cumulative Update 
1. From Internet Explorer, go to https://dsm.deltek.com.  

2. Click Run Deltek Software Manager.  

3. Log in using your Deltek Customer Care Connect credentials.  

4. In the left pane of the Deltek Software Manager, expand your Deltek product.  

5. Expand the Cumulative Updates folder for your product, and select the update to download.  

6. Click Download at the bottom of the screen. 

Install the Cumulative Update 
Use the instructions below that apply to the Cobra version you use. 

 

For Cobra 8.x and Higher 
The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment. Use 
the instructions below that apply to your deployment scenario. 

 

If You Use a Deployment Server 

To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: You must install the entire update package. If an update addresses more than one defect, you 
cannot fix one defect at a time. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 

https://dsm.deltek.com/
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6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish.  

7. Launch the Deltek Cobra shortcut on client workstations to initiate the update. 

To install on a client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. When the installation 
is completed, the installation wizard closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have an N-Tier Deployment 

To install on the server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

 

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update. 

To install on an n-tier client workstation: 

1. Launch the Deltek Cobra shortcut. Cobra detects that an updated version is available and 
displays the prompt: Do you want to install the upgrade?  

2. Choose Yes to start the installation or choose No to cancel the installation. If you choose Yes, 
the installation wizard copies the updated DeltekCobraWorkstation.exe file locally and 
automatically begins installing files. When the installation is completed, the installation wizard 
closes.  

3. Launch the Deltek Cobra shortcut to log into Cobra. 

If You Have a Terminal Services/Citrix Deployment 

To install on the deployment server: 

1. Verify that Cobra is not running.  

2. Launch the update on the server. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish. 

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Log on as a Local Administrator on the Terminal Server/Application Server and install the update. 

To install on the Terminal Server/ Application Server (the server on which the Cobra client runs): 

1. Log on to the Terminal Server using an account that has Local Administrator privileges. When the 
setup launches, the installation program installs all necessary files and any registry updates and 
makes these changes available to all users who will subsequently log on to the Terminal Server 
session to run Cobra.  

2. Ensure that no instance of Cobra is running.  

3. Browse to the shared Cobra Workstation folder (usually located on the deployment server, as 
\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).  

4. Launch the DeltekCobraWorkstation.exe file to install the update. The Welcome screen displays, 
showing that the update is available.  

5. Click Next to start the installation.  

6. When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm 
that the update is installed, meaning that users can now launch Cobra via Terminal 
Services/Citrix sessions. 

If You Have a Standalone Deployment 

To install on the workstation: 

1. Verify that Cobra is not running.  

2. Launch the update on the server.  

3. The Welcome screen displays the current build, along with the new build being installed by the 
update. Click Next to begin the installation.  

4. The installation wizard installs all necessary files and displays the Update Complete form.  

5. Click Finish.  

6. Depending on the type of update, a reboot may be required. If the option to reboot your computer 
is enabled, select it and click Finish. 

7. Launch the Deltek Cobra shortcut to log into Cobra. 

Confirm that the Cumulative Update is Installed 

1. Click  » Help » About Deltek Cobra. 

Note: If the update detects that Cobra is already running, you will see a prompt asking if you want to 

close Cobra. Choose Yes to start the installation or choose No to cancel the installation. 
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2. Check that the version number reflects the installation of the update. 
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Appendix B: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 

 Search for product documentation, such as release notes, install guides, technical information, 
online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  

1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/


 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

 

http://www.deltek.com/
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